Trademarks
The following are trademarks of Motorola: MOTOTRBO™.
Any other brand or product names are trademarks or registered trademarks of their respective holders.

The Genesis Group Trademark Information
GW3-TRBO® is a registered trademark of GenCore Candeo, LTD., a subsidiary of Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks.

Copyright
Copyright © 2006-2020 ; Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks. All rights are reserved. No part of this publication or the associated program may be reproduced, transmitted, transcribed, in whole or in part, in any form or by any means, whether it is mechanical, magnetic, optical, electronic, manual or otherwise, without the prior written consent of Burks GenCore Co., Inc. D.B.A: The Genesis Group and Phil Burks
5800 Eagles Nest Blvd
Tyler, Texas 75703.

Includes technology licensed from Motorola.

Disclaimer
The GW3-TRBO Users’ Manual is printed in the U.S.A. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks believe that the information included in this manual is correct; however, Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks reserves the right to alter, revise and make periodic changes to the manual and its contents. Burks GenCore Co., Inc. D.B.A. The Genesis Group does not assume responsibility to notify any person of such revisions or changes. While we have taken strides to carefully examine our software and documentation and believe that it is reliable, the Genesis Group and Phil Burks assume no responsibility for the use of the manual, or GW3-TRBO software, nor for any patent infringements or other rights of third parties who may use the manual or the GW3-TRBO software. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks make no representations or warranties with respect to the contents or fitness for a particular purpose beyond the cost of the software paid by the end-user.

The software contains valuable trade secrets and proprietary information. Unauthorized use of the manual or software can result in civil damages and criminal prosecution. As an end user, you agree to abide by and heed these statements.

License
Title to the media on which the program is recorded and to the documentation in support of the product is transferred to you, but title to the program, and all subsequent copies of the program, despite the form or media in or on license is not a sale of the original or any subsequent copy. You assume responsibility for the selection of the program to achieve your intended results, and for the installation, use, and results obtained from the program.

Refer to the GW3-TRBO Manual Overview for your full license. All license information contained on pages 4-7 (book 600-2.16.15-AA.1) are to be considered as contained herein.

Support
Customer satisfaction is our number one priority at Genesis. We are here to provide you with the best software possible, and we want to know when you have any questions, concerns, or problems with GW3-TRBO so that we can make it a better product for everyone.

Refer to the Troubleshooting & Support section of the GW3-TRBO Manual Shell (Book 600-2.16.15-AA.1) for complete support and contact information.
## Document History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0.5</td>
<td>Initial Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.0.5</td>
<td>Replaced GW3-TRBO trademark with registered trademark.</td>
<td>JAW</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Replaced screenshots 4.1, 5.1 and 7.1</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Updated screenshots</td>
<td>KIH</td>
</tr>
<tr>
<td>2.0.6.6</td>
<td>Revisions for release</td>
<td>TDW</td>
</tr>
<tr>
<td>2.1</td>
<td>Added IP Console Inhibit and Slot Disable Security privileges</td>
<td>REB</td>
</tr>
<tr>
<td>2.1</td>
<td>Revisions before release</td>
<td>REB</td>
</tr>
<tr>
<td>2.2</td>
<td>Initial Version Update</td>
<td>CWF</td>
</tr>
<tr>
<td>2.2</td>
<td>Document Reviewed</td>
<td>WRK</td>
</tr>
<tr>
<td>2.3</td>
<td>Update security privileges list</td>
<td>WRK</td>
</tr>
<tr>
<td>2.4</td>
<td>Initial Version Update</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Added Emergency Display section</td>
<td>KIH</td>
</tr>
<tr>
<td>2.5</td>
<td>Added Changing Global Settings section</td>
<td>REB</td>
</tr>
<tr>
<td>2.6</td>
<td>Added Security Warning Banner</td>
<td>REB</td>
</tr>
<tr>
<td>2.6</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.7</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.8</td>
<td>Revisions Before Release</td>
<td>WRK</td>
</tr>
<tr>
<td>2.9</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.9</td>
<td>Updated “Viewing Real-Time Module Status” section in Chapter 6.</td>
<td>REB</td>
</tr>
<tr>
<td>2.10</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.11</td>
<td>Converted to Docx format</td>
<td>CWF</td>
</tr>
<tr>
<td>2.11</td>
<td>Added APM module</td>
<td>JAW</td>
</tr>
<tr>
<td>2.11</td>
<td>Added KPI module</td>
<td>BUD</td>
</tr>
<tr>
<td>2.12</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.13</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.14</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.15</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.16</td>
<td>Revisions Before Release</td>
<td>JPS</td>
</tr>
</tbody>
</table>
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trademarks</td>
<td>3</td>
</tr>
<tr>
<td>The Genesis Group Trademark Information</td>
<td>3</td>
</tr>
<tr>
<td>Copyright</td>
<td>3</td>
</tr>
<tr>
<td>Disclaimer</td>
<td>3</td>
</tr>
<tr>
<td>License</td>
<td>3</td>
</tr>
<tr>
<td>Support</td>
<td>3</td>
</tr>
<tr>
<td>DOCUMENT HISTORY</td>
<td>4</td>
</tr>
<tr>
<td><strong>TABLE OF CONTENTS</strong></td>
<td>5</td>
</tr>
<tr>
<td><strong>ABOUT THIS MANUAL</strong></td>
<td>9</td>
</tr>
<tr>
<td>Goals</td>
<td>9</td>
</tr>
<tr>
<td>Who Should Read This Manual?</td>
<td>9</td>
</tr>
<tr>
<td>How This Manual Is Organized</td>
<td>9</td>
</tr>
<tr>
<td><strong>CHAPTER 1 INSTALLATION</strong></td>
<td>11</td>
</tr>
<tr>
<td>Installation Information</td>
<td>11</td>
</tr>
<tr>
<td><strong>CHAPTER 2 OVERVIEW</strong></td>
<td>13</td>
</tr>
<tr>
<td>Terms</td>
<td>13</td>
</tr>
<tr>
<td>Welcome</td>
<td>13</td>
</tr>
<tr>
<td>What is GW3-TRBO?</td>
<td>13</td>
</tr>
<tr>
<td>Core Applications and Modules</td>
<td>14</td>
</tr>
<tr>
<td>Input and/or Output Modules</td>
<td>14</td>
</tr>
<tr>
<td>Process and/or Display Modules</td>
<td>15</td>
</tr>
<tr>
<td>Reporting Modules</td>
<td>16</td>
</tr>
<tr>
<td>Tools</td>
<td>17</td>
</tr>
<tr>
<td>GW3-TRBO and Windows Security</td>
<td>17</td>
</tr>
<tr>
<td>Basic Input and Output</td>
<td>17</td>
</tr>
<tr>
<td>TCP/IP Communication</td>
<td>18</td>
</tr>
<tr>
<td><strong>CHAPTER 3 GW3-TRBO SERVICE</strong></td>
<td>19</td>
</tr>
<tr>
<td>Windows Services</td>
<td>19</td>
</tr>
<tr>
<td>Why is GW3-TRBO a Service?</td>
<td>19</td>
</tr>
<tr>
<td>Administering Windows Services</td>
<td>19</td>
</tr>
<tr>
<td>Delayed Start option</td>
<td>20</td>
</tr>
<tr>
<td>GW3-TRBO Service Overview</td>
<td>21</td>
</tr>
<tr>
<td>GW3-TRBO Service Diagnostics</td>
<td>21</td>
</tr>
<tr>
<td>Module Health</td>
<td>21</td>
</tr>
<tr>
<td>GW3-TRBO Config Files</td>
<td>22</td>
</tr>
<tr>
<td>Service Config Files</td>
<td>22</td>
</tr>
<tr>
<td>GUI Config Files</td>
<td>24</td>
</tr>
<tr>
<td>Updating a Config File</td>
<td>26</td>
</tr>
<tr>
<td>Database Size Notifications</td>
<td>26</td>
</tr>
<tr>
<td>Staging for Windows Authentication</td>
<td>26</td>
</tr>
<tr>
<td>Domains</td>
<td>26</td>
</tr>
<tr>
<td>Workgroups</td>
<td>27</td>
</tr>
<tr>
<td><strong>CHAPTER 4 GW3-TRBO MODULE GUIS OVERVIEW</strong></td>
<td>29</td>
</tr>
<tr>
<td>What are Module GUIs?</td>
<td>29</td>
</tr>
<tr>
<td>Common Module GUI Buttons</td>
<td>29</td>
</tr>
<tr>
<td>Module Connection Displays and Functions</td>
<td>30</td>
</tr>
</tbody>
</table>
CURRENT USERS ........................................................................................................68
Logging Out a User .......................................................................................................69

CHAPTER 9  SYSLOG GUI ..........................................................................................71
WHAT IS SYSLOG? ........................................................................................................71
SYSLOG PACKETS ......................................................................................................72
    SysLog PRI Facility Values ..................................................................................72
    SysLog PRI Severity Values .............................................................................73
SYSLOG CONNECTIONS ..............................................................................................73
    Creating a SysLog Connection .......................................................................73
    Deleting a SysLog Connection .......................................................................73
    Disabling a SysLog Connection ....................................................................74

CHAPTER 10  WEBSERVER MODULE .........................................................................75
WHAT IS THE WEB SERVER MODULE? ...................................................................75
WEB SERVER CONFIGURATION ................................................................................75
WEB SERVER REQUEST TYPES ................................................................................76

CHAPTER 11  GW3-TRBO NOTIFICATIONS ................................................................77
WHAT IS A NOTIFICATION? ......................................................................................77
WHAT DO NOTIFICATIONS MEAN TO ME? .........................................................78
WORKING WITH NOTIFICATIONS ....................................................................78

CHAPTER 12  AUTOMATIC PURGING .......................................................................79
WHAT IS AUTOMATIC PURGING? ..........................................................................79
AUTOMATIC PURGE SETTINGS .............................................................................79
VIEWING PURGING RESULTS ...............................................................................80
About this Manual

Goals
This document informs and instructs users on the operation of the core Graphical User Interfaces (GUIs) and modules for GW3-TRBO.

Who Should Read This Manual?
This manual was written for an audience of MOTOTRBO radio system administrators with novice to mid-level computer experience.

How This Manual Is Organized
This manual is organized into the following chapters:

- **Installation**: Provides a list of reference documents for hardware and software installation.
- **Overview**: Gives an overview of the GW3-TRBO solution.
- **GW3-TRBO Service**: Describes the function and role of the GW3-TRBO service in the GW3-TRBO solution.
- **GW3-TRBO Module GUIs Overview**: Describes the common functions of each GW3-TRBO module graphical user interface (GUI).
- **Alerts**: Describes the function and role of the Alerts System Tray application.
- **Launch GUI**: Describes the function and role of the Launch GUI.
- **GW3-TRBO License Manager**: Describes the function and role of the GW3-TRBO License Manager.
- **Security GUI**: Describes the function and role of the Security GUI.
- **SysLog GUI**: Describes the function and role of the SysLog GUI.
- **WebServer**: Describes the function and role of the WebServer module.
- **GW3-TRBO Notifications**: Describes the GW3-TRBO GUI Notification window shown by Alerts.
- **Automatic Purging**: Describes the need and function of the automatic purging operation within GW3-TRBO.

This manual contains the following images, used to indicate that a segment of text requires special attention:

- **Additional Information**: Additional information is used to indicate shortcuts or tips.

- **Warning**: Warnings are used to indicate possible problem areas, such as a risk of data loss or incorrect/unexpected functionality.
Chapter 1  Installation

This chapter contains the following sections:
- **Installation Information**: Describes where to find installation information.

**Installation Information**

For installation instructions and minimum hardware requirements, see the *GW3-TRBO Installation and Quickstart Guide*.

For hardware installation instructions, refer to the *Hardware Installation Guide*.

❌ The GW3-TRBO machine must use an English-language version of Microsoft Windows using the English language set.
Chapter 2

Overview

This chapter contains the following sections:

- **Terms**: An introduction of basic terms used in this manual.
- **Welcome**: Welcomes you to the Genesis GW3-TRBO product.
- **What is GW3-TRBO?**: Defines the GW3-TRBO product.
- **GW3-TRBO and Windows Security**: Describes the security needs of GW3-TRBO.

**Terms**

- **Packet**: This is a message sent from a MOTOTRBO device to GW3-TRBO or a message sent from GW3-TRBO to an ISP/ISW capable device.
- **Module**: This is a part of the GW3-TRBO solution. Each module performs a specific function within GW3-TRBO. For example, the Group module organizes and shows real-time Push-to-Talk activity, while the Trbo module manages connections to MOTOTRBO devices.
- **Windows Service**: A Windows service is an application that runs behind the scenes. Services automatically load when the computer boots up.
- **Port**: A data connection in a computer that allows local and/or remote access.

**Welcome**

Thank you for allowing Genesis to help you with your software needs. Genesis has combined our technology for decoding data streams, the power of Microsoft .Net development, and our expertise in software design and implementation into a single, scalable application.

**What is GW3-TRBO?**

GW3-TRBO is a dynamic data process solution. This means that GW3-TRBO can accept and decode proprietary packet interfaces and encode, display, archive, relay, and respond to these packets. Because of its design, GW3-TRBO modules can satisfy almost any data process needs of the MOTOTRBO owner.

The GW3-TRBO GUIs and modules are divided into the following categories:

- Core
- Input and/or output
- Process and/or display
- Reporting

The core modules are shown in Table 2.1 below. Each additional module is defined within its own respective GW3-TRBO module book.
Core Applications and Modules

The following core GUIs and modules are those required for minimum GW3-TRBO setup and functionality.

<table>
<thead>
<tr>
<th>Module Name</th>
<th>Description</th>
<th>Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>GW3-TRBO Service</td>
<td>Windows service that loads and runs all GW3-TRBO modules.</td>
<td>600-2.16.15-A.1</td>
</tr>
<tr>
<td>Alerts</td>
<td>Shows the status of GW3-TRBO input connections. Shows notifications sent by GW3-TRBO, via Notification windows. Provides an entry point for Launch. This GUI is also where you log in to GW3-TRBO.</td>
<td>600-2.16.15-A.1</td>
</tr>
<tr>
<td>Launch</td>
<td>Provides a single interface to load each module GUI and each tool provided by GW3-TRBO.</td>
<td>600-2.16.15-A.1</td>
</tr>
<tr>
<td>Security</td>
<td>Centralized security GUI/module for GW3-TRBO. The users, roles, and privileges defined in this module affect the display and function of each module’s GUI within GW3-TRBO.</td>
<td>600-2.16.15-A.1</td>
</tr>
<tr>
<td>SysLog</td>
<td>Reports GW3-TRBO service and module activity to one or more remote IP ports via SysLog packets. These packets can be received and parsed by third-party SysLog client software.</td>
<td>600-2.16.15-A.1</td>
</tr>
<tr>
<td>WebServer</td>
<td>Handles incoming GW3-TRBO web requests and their responses.</td>
<td>600-2.16.15-A.1</td>
</tr>
</tbody>
</table>

Table 2.1 – Core Applications and Modules

Input and/or Output Modules

The input and/or output modules accept input from and/or provide output to a specific data stream. The following input and/or output modules are currently available or planned for GW3-TRBO.

<table>
<thead>
<tr>
<th>Module Name</th>
<th>Description</th>
<th>Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trbo</td>
<td>Receives data from a MOTOTRBO device. Supports connections in IP Site Connect, Capacity Plus and Linked Capacity Plus modes, as well as diagnostic-only connections to Connect Plus repeaters.</td>
<td>600-2.16.15-LL.1</td>
</tr>
<tr>
<td>Connect</td>
<td>Receives data from Connect Plus, APM, SNMP, SMTP Server, TRBO ATIA, TRBO Wireline Gateway, Connect Plus Configuration Services, SmartPTT Subscriber GPS, and NeoTerra Subscriber GPS devices.</td>
<td>600-2.16.15-MM.1</td>
</tr>
</tbody>
</table>

Table 2.2 – Input and/or Output Modules
**Process and/or Display Modules**

Process and/or display modules perform specific functions on the packets generated by the input modules (GW3-TRBO input). Some of these modules provide user interfaces, which result in commands sent out to a data stream connected to the input and/or output modules (GW3-TRBO output). In addition to the core modules, the following process and/or display modules can be licensed for this version of GW3-TRBO:

<table>
<thead>
<tr>
<th>Module Name</th>
<th>Description</th>
<th>Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Displays all activity received over the data stream in real time. This data includes system events such as Repeater Diagnostics and Link Establishment Messages. This GUI also includes call activity such as group and private calls. Each packet type can be excluded or included via the options at the top of the GUI.</td>
<td>600-2.16.15-E.1</td>
</tr>
<tr>
<td>Affiliation</td>
<td>Shows the real-time connection state of radios.</td>
<td>600-2.16.15-F.1</td>
</tr>
<tr>
<td>Alias</td>
<td>Accepts input packets, dynamically adds new resources as they appear on the data stream, appends alias information to input packets and passes each appended packet onto the other modules.</td>
<td>600-2.16.15-G.1</td>
</tr>
<tr>
<td>APM</td>
<td>Shows APM channel status information in site and subsite windows.</td>
<td>600-2.16.15-TT.1</td>
</tr>
<tr>
<td>Archiver</td>
<td>Archives information received over the data stream into the database. Can optionally archive everything from call activity to repeater diagnostics. This archived data feeds the GW3-TRBO reports.</td>
<td>600-2.16.15-H.1</td>
</tr>
<tr>
<td>Channel</td>
<td>Shows real-time channel usage as well as busies and diagnostics received over the data stream.</td>
<td>600-2.16.15-I.1</td>
</tr>
<tr>
<td>GEnSAC</td>
<td>Converts input packets into defined output packets. These packets are built, filtered, and sent to consoles.</td>
<td>600-2.16.15-Z.1</td>
</tr>
<tr>
<td>GenSPOut</td>
<td>Converts input packets into defined output packets. These packets are built, filtered, and sent based on interfaces and connection definitions created within GenSPOut.</td>
<td>600-2.16.15-K.1</td>
</tr>
<tr>
<td>Group</td>
<td>Shows real-time PTT/call activity, in individual, customizable group windows.</td>
<td>600-2.16.15-L.1</td>
</tr>
</tbody>
</table>
### Module Name | Description | Document
---|---|---
Halcyon | Manages radio commands and their corresponding ACKs. Accepts RC connections, processes requests from the connections, and passes qualified system events to these connections. Works with SAM and System Map to allow them to issue radio commands. | 600-2.16.15-T.1
KPI | Displays real-time, interactive and statistical information on WACNs, Systems, Zones and Sites. | 600-2.16.15-UU.1
SAM | Monitors predefined ranges of groups and radio IDs for usage outside predefined usage patterns. Also watches for overlapping calls that could be cloned radio activity. | 600-2.16.15-J.1
SysSummary | Shows real-time graphical system usage for radio systems. | 600-2.16.15-N.1
System Map | Shows detailed, near-real time information about each peer registered under a common MOTOTRBO System. | 600-2.16.15-VV.1
SysVista | Shows real-time graphical dash-board system usage statistics for radio systems. | 600-2.16.15-O.1
Trigger | Monitors GW3-TRBO packets for predefined patterns that result in external relay or audio-visual alerts. | 600-2.16.15-S.1

Table 2.3 – Process and/or Display Modules

**Reporting Modules**

Reporting modules display information recorded in the GW3-TRBO database. The following reporting modules can be licensed for this version of GW3-TRBO:

### Module Name | Description | Document
---|---|---
Reports | Provides an interface to launch the canned reports offered in GW3-TRBO. | 600-2.16.15-Y.1

Table 2.4 – Reporting Modules
Tools

The following applications are available in the Tools section of Launch. Tools provide supplemental setup or functionality within GW3-TRBO. See Chapter 6 – Launch GUI of this book for more information on Launch tools. The following tools can be licensed for this version of GW3-TRBO:

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>RC</td>
<td>Loads the RC application. RC allows you to issue radio commands such as inhibit and call alert. RC also provides a workflow for radio events such as emergency alarms.</td>
<td>600-2.16.15-V.1</td>
</tr>
</tbody>
</table>

Table 2.5 – Tools

GW3-TRBO and Windows Security

Basic Input and Output

The GW3-TRBO GUIs use the security context of the currently logged-in Windows user to access TCP/IP ports, read from files, write to files and many other functions. Some Windows installs may limit these functions.

For simple installs, the best way to ensure that your Windows user can perform these functions is to log into Windows using the Administrator user or a user with full administrative access to the machine. Simple installs include only machines that are not part of a domain.

For installs that include computers on a domain, you might need to set up some security options on the domain controller for your user and/or the GW3-TRBO machine. When in doubt, check with your IT department, or contact GW3-TRBO support.

The GW3-TRBO Host installation includes a Windows service named GenWatchService. The GW3-TRBO service is designed to run under the built-in Windows user account LOCAL SYSTEM. If you choose to run GW3-TRBO under another user, you must ensure that this Windows user has the following privileges:

- Read/write access to databases in SQL Server.
- Read/write access on this machine to the Application Data directory. By default, this directory is C:\ProgramData\Genesis\GenWatch3.
- Authorization to open TCP/IP connections on this machine.
- If your install includes one or more client machines, authorization to create/receive TCP/IP connections from and to this machine.
TCP/IP Communication

When a GW3-TRBO GUI connects to a module, the following occurs:

1. The GUI presents its Windows user as a security principle to the module. If the user is valid on the network, the process continues. (See the SuperListener_Authenticate event in the event log.)

2. The GUI and module PCs negotiate the type of encryption to be used based on the Authentication Type presented by the security principle in step 1. This is typically NTLM or Kerberos.

3. The GUI requests TCP/IP packet compression to be on or off based on the option selected during the GW3-TRBO client install. If enabled, all packets over 1024 bytes will be compressed before they are sent over the network.

See the GW3-TRBO Config Files section of this document for more information on viewing and changing the encryption and compression options.
This chapter contains the following sections:

- **Windows Services**: Defines Windows services and gives an overview of their function.
- **GW3-TRBO Service Overview**: Defines the GW3-TRBO service.
- **GW3-TRBO Config Files**: Describes the options contained within the GW3-TRBO configuration files.
- **Database Size Notifications**: Describes the messages sent by GW3-TRBO to inform the user when the database is nearing its size limit.

### Windows Services

A service is an application that runs in the background on a Windows PC. If a service is set to “Automatic”, the service will start when the machine is booted and, in most cases, will load by the time Windows presents its login window. If it is not loaded in time, a simple error message will display.

### Why is GW3-TRBO a Service?

GenWatch3 must always be running so that it can archive and process activity on your system. Windows services do not require user interaction to load, so they will run even if the host PC is rebooted in the middle of the night.

### Administering Windows Services

Services are administered via the Windows *Computer Management* application. To access this application:

1. Right-click on the **My Computer** icon on your desktop. This will result in a menu of options, including the **Manage…** option.
2. Click on the **Manage…** option in the menu. This will load the *Computer Management* window.
3. Expand the **Services and Applications** node in the tree on the left of the window.
4. Click on the **Services** node. This will show a list of all services registered on your PC in a list on the right of the window.
5. Find the GW3-TRBO service in the list (it is named *GenWatchService*).

At this point you can right-click on the service to receive a list of service options. These options include:

- **Start** – Starts the service (Only available if the service is stopped)
- **Stop** – Stops the service (Only available if it is started)
- **Pause** - Pauses the service (Only available if it is started)
- **Resume** - Starts the service (Only available if it is paused)
- **Restart** – Stops the service, then starts the service (Only available if it is started)
- **Properties** – Displays the details about the selected service
Delayed Start option

Computers with minimal amounts of processing power may have difficulty starting all their services when they boot. This can affect the GW3-TRBO service because it requires other services to be running when it starts. You may find messages in the Event Log stating, “The service did not respond to the start or control request in a timely fashion.” In this situation, setting the Startup type of the GW3-TRBO service to Delayed Start can help.

This will delay the service’s startup when the computer reboots and allow other services to start first.

To change the setting, follow the instructions listed above in the Administering Windows Services section to access the service properties. Change the Startup type option on the General tab and click OK.

Figure 3.1 – GW3-TRBO service configured for Delayed Start
GW3-TRBO Service Overview

When the GW3-TRBO service is started, it loads all the GW3-TRBO modules that are included in your GW3-TRBO license. The service then starts all these loaded modules. Once started, these modules begin to perform their specific tasks. These tasks may include anything from receiving and parsing a data stream to archiving the parsed data stream to an SQL database.

If the GW3-TRBO service is stopped, it will unload all modules. The modules will not process data until the service is restarted.

GW3-TRBO Service Diagnostics

The GW3-TRBO service reports activity to the Windows Event Log. You can access the Windows event log by taking the following steps:

1. Right-click on the My Computer icon.
2. Select Manage….
3. Expand the Event View node under the System Tools node.
4. Expand the Application and Services Logs node under the Event Viewer node.
5. Click on the GenWatch node under the Event View node.

The list that appears on the right contains GW3-TRBO events reported by the GenWatchService service. All GW3-TRBO events contain “GW_” in the Source column, except for GenWatchService, which can be found in the same area. Double-click on an entry to view that entry’s details.

Figure 3.1 – Error and Information Event Log Entries

Module Health

Every 5 minutes, the GW3-TRBO service logs module health information for each module in the module health log. The log files are stored in the following directory:

<Application Data>\Logs\GenWatchService

By default, the Application Data directory is C:\ProgramData\Genesis\GenWatch3. The module health folders contain a log file for each day, with a maximum of 14 days of log history.
GW3-TRBO Config Files
The GW3-TRBO service and GUIs use config files to store settings central to the service or logged in Windows user.

Service Config Files
This config file is named GenWatch3.config and is stored in the following location:

The Application data folder: C:\ProgramData\Genesis\GenWatch3.

Changes made to the service’s GenWatch3.config file will require a service restart to take effect.

The following table shows values that may appear in the service config file:

<table>
<thead>
<tr>
<th>Config File Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AliasBatchAmount</td>
<td>Number of Alias update SQL commands needed to execute a batch update. For large multisite installations, this number should be raised to 500 or 1,000 to decrease SQL service usage. Each time GW3-TRBO is upgraded, it will update this setting to a minimum of 200.</td>
</tr>
<tr>
<td>AliasBatchMaxSeconds</td>
<td>Maximum number of seconds Alias will wait before executing any batched SQL commands.</td>
</tr>
<tr>
<td>ArchiverBatchAmount</td>
<td>Number of Archiver SQL commands needed to execute a batch command. For large multisite installations, this number should be raised to 500 or 1,000 to decrease SQL service usage. Each time GW3-TRBO is upgraded, it will update this setting to a minimum of 200.</td>
</tr>
<tr>
<td>ArchiverBatchMaxSeconds</td>
<td>Maximum number of seconds Archiver will wait before executing any batched SQL commands.</td>
</tr>
<tr>
<td>DatabaseName</td>
<td>Name of the GW3-TRBO database.</td>
</tr>
<tr>
<td>DynamicAdd</td>
<td>Determines if resources (such as IDs and Groups) should be dynamically added to the Alias database if mentioned in data.</td>
</tr>
<tr>
<td>ExpireIds</td>
<td>Remove IDs from Alias if the maximum number is exceeded.</td>
</tr>
<tr>
<td>GW3ServerName</td>
<td>Name of the machine hosting the service.</td>
</tr>
<tr>
<td>IgnoreFccSignalInterference</td>
<td>Toggles the option to hide all FCC Signal Interference diagnostics from the Trbo module and the Connect module’s Connect Plus connections. When ignored, these diagnostics will not be archived or displayed in any way.</td>
</tr>
<tr>
<td><strong>Config File Value</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Impersonate</td>
<td>Determines if this installation should use Windows user impersonation in relation to SQL interaction.</td>
</tr>
<tr>
<td>InstallFilePath</td>
<td>Location of GW3-TRBO application.</td>
</tr>
<tr>
<td>InstallType</td>
<td>Not used.</td>
</tr>
<tr>
<td>IPVersion</td>
<td>IP version used on this machine. Options include <strong>IPv4</strong> and <strong>IPv6</strong></td>
</tr>
<tr>
<td>KPIDatabaseName</td>
<td>Name of the KPI database.</td>
</tr>
<tr>
<td>MaxDatabaseSize</td>
<td>Maximum database size expected in MB. This results in a warning when the database approaches this size. i.e. 9 GB would be 9000.</td>
</tr>
<tr>
<td>RawDataFilePath</td>
<td>Root path where raw data files generated by input modules are stored.</td>
</tr>
<tr>
<td>RestartService</td>
<td>Not used.</td>
</tr>
<tr>
<td>SerialNumber</td>
<td>Serial number of this installation.</td>
</tr>
<tr>
<td>ServerName</td>
<td>Name of the machine hosting the SQL Server database.</td>
</tr>
<tr>
<td>ThrottleRate</td>
<td>Not applicable for GW3-TRBO.</td>
</tr>
<tr>
<td>Trio</td>
<td>Determines if Trio is installed.</td>
</tr>
<tr>
<td>TrioDBServerName</td>
<td>Name of the machine hosting the Trio SQL database.</td>
</tr>
<tr>
<td>UseTcpCompression</td>
<td>Toggles the option for TCP/IP compression between a module and its GUI.</td>
</tr>
<tr>
<td>UseTcpEncryption</td>
<td>Toggles the option for TCP/IP encryption and Windows credential authentication between a module and its GUI. If enabled, the module PC must trust the domain of the GUI PC. If a workgroup is involved, the Windows user logged into the GUI must exist with the same password under the Windows security of the module.</td>
</tr>
<tr>
<td>RestApiClientTcpPort</td>
<td>The port configured during the configuration of the host to be used by the WebServer module. Changing this may cause the module to be unable to handle requests due to other firewall and URI reservation requirements configured during installation/configuration of the host.</td>
</tr>
<tr>
<td>RestApiRequestLogging</td>
<td>Enables logging of all WebServer requests.</td>
</tr>
<tr>
<td>RestApiVerboseLogging</td>
<td>Used with the RestApiRequestLogging setting to include the body of requests and responses in the log.</td>
</tr>
</tbody>
</table>
GUI Config Files

This config file is also named *GenWatch3.config* and is stored in the following location:

**The Windows login user documents folder:** `C:\Users<Windows User>\Documents\Genesis\GenWatch3`.

Changes made to the GUI GenWatch3.config file may require you to reload the GUI to take effect.
The following table shows values that may appear in the GUI config file:

<table>
<thead>
<tr>
<th>Config File Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AgencySelector</td>
<td>State information regarding the Agency selector form.</td>
</tr>
<tr>
<td>AliasImportPath</td>
<td>The last path specified during an alias import</td>
</tr>
<tr>
<td>DatabaseName</td>
<td>Name of the GenWatch3 database.</td>
</tr>
<tr>
<td>DebugUnlock</td>
<td>Encrypted debug unlock code provided by support during a support session.</td>
</tr>
<tr>
<td>DynamicAdd</td>
<td>Not used.</td>
</tr>
<tr>
<td>GW3HostMachine</td>
<td>Name of the machine hosting the service.</td>
</tr>
<tr>
<td>GW3HostMachineList</td>
<td>List of machine names used as hosts.</td>
</tr>
<tr>
<td>GW3ServerName</td>
<td>Not used.</td>
</tr>
<tr>
<td>IDSelector</td>
<td>State information regarding the ID selector form.</td>
</tr>
<tr>
<td>InstallPath</td>
<td>Not used.</td>
</tr>
<tr>
<td>InstallType</td>
<td>Not used.</td>
</tr>
<tr>
<td>IPVersion</td>
<td>Not used.</td>
</tr>
<tr>
<td>KPIDatabaseName</td>
<td>Name of the KPI database.</td>
</tr>
<tr>
<td>LastLoginInfo</td>
<td>Obsolete.</td>
</tr>
<tr>
<td>LastLoginName</td>
<td>Last user that logged into GW3-TRBO on this machine.</td>
</tr>
<tr>
<td>RawDataFilePath</td>
<td>Not used.</td>
</tr>
<tr>
<td>SerialNumber</td>
<td>Not used.</td>
</tr>
<tr>
<td>ServerName</td>
<td>Name of the machine hosting the SQL Server database.</td>
</tr>
<tr>
<td>SiteSelector</td>
<td>State information regarding the Site selector form.</td>
</tr>
<tr>
<td>TGSelector</td>
<td>State information regarding the Talkgroup selector form.</td>
</tr>
<tr>
<td>Trio</td>
<td>Not used.</td>
</tr>
<tr>
<td>TrioDBServerName</td>
<td>Not used.</td>
</tr>
<tr>
<td>UnitHistoryFromDT</td>
<td>Last from date/time used by this Windows user of this machine.</td>
</tr>
<tr>
<td>UnitHistoryToDT</td>
<td>Last to date/time used by this Windows user of this machine.</td>
</tr>
<tr>
<td>UseTcpCompression</td>
<td>Toggle the compression option for TCP/IP data transferred between a module and its GUI. If enabled, each packet over 1K is compressed.</td>
</tr>
<tr>
<td>ZoneSelector</td>
<td>State information regarding the Zone/RFSS selector form.</td>
</tr>
</tbody>
</table>
Updating a Config File

To update config file settings, take the following steps:

1. Browse to the config file path. For service config file options, refer to the *Service Config Files* section above. For GUI config file options, refer to the *GUI Config Files* section above.
2. Double-click on the *GenWatch3.config* file. This may result in a dialog asking you to choose an application to use to open this file. In this case, choose Microsoft Notepad.
3. Update the config file value(s) you wish to change.
4. Click File and Save to save your changes.

⚠️ Depending on your PC’s User Access Control (UAC) settings, you may need to run your text editor as Administrator in order to save the service’s GenWatch3.config file.

Database Size Notifications

The GW3-TRBO service issues a notification to all connected Alerts users when the database is reaching the maximum expected database size specified by the *MaxDatabaseSize* value in the service config file.

The default maximum expected database size is 9,000 megabytes (about 9 gigabytes). To update this value, follow the steps in the *Updating a Config File* section above.

⚠️ Microsoft SQL Express has a size limitation of about 10 gigabytes. If you change the *MaxDatabaseSize* on a Microsoft SQL Express install of GW3-TRBO to more than 10 GB, you will encounter severe issues.

⚠️ Changing this setting may void your warranty. If you find it necessary to change this value, please contact Genesis support.

Staging for Windows Authentication

You can use two methods of authentication for GW3-TRBO, Genesis and Windows. This section covers Windows Authentication for domains and workgroups.

Domains

Windows Authentication on domains requires a bit of planning and staging with your Windows Domain and SQL administrators. For each role you wish each user to assume in GW3-TRBO, you will need a Windows security group. These Windows security groups must exist as SQL instance logins within the SQL instance that houses the GW3-TRBO database. Additionally, these SQL instance logins must be mapped to the GW and KPI databases using the db_gw3user role.
For example, given that an administrator role called gw3admin in the cty domain that will serve an administrator role in GW3-TRBO. And Windows user cty\dave will be one of the users that assumes this role. Set up the following:

1. In the GW3-TRBO Security module, create the cty\gw3admin role and assign the desired privileges.
2. Add the cty\gw3admin security group to the domain's security groups.
3. Assign the cty\gw3admin role to Windows user cty\dave.
4. In the SQL instance, add cty\gw3admin as a login.
5. Map cty\gw3admin to databases GW and KPI using role db_gw3user.

The first time cty\dave logs into GW3-TRBO, cty\dave will be auto created in the SEC_Users table with a role of gw3admin.

⚠️ Be careful not to assign multiple security groups used in GW3-TRBO to your Windows users. Windows users logging into GW3-TRBO must have exactly one domain security group that exists as a role in the SEC_Roles table. These are matched on <domain>\<name> (i.e. cty\gw3admin is used for the gw3admin security group on domain cty). If there is not exactly one match, the user will be rejected.

### Workgroups

Genesis Authentication is recommended for workgroups because they do not have a central authentication system. Each machine in a workgroup must be configured independently. If you would like to use Windows Authentication, please see the following information.

For each role you wish a user to assume in GW3-TRBO, you will need a Windows security group on each computer that will be used to log into the application. These Windows security groups must exist as SQL instance logins within the SQL instance that houses the GW3-TRBO database with the same computer name as the machine that hosts the GW3-TRBO service. Additionally, these SQL instance logins must be mapped to the GW and KPI databases using the db_gw3user role. A user must have the same Windows password on all machines in the workgroup.

As an example, consider a network with two computers. SystemHost is the host computer that runs GW3-TRBO and the GW3-TRBO database. SystemClient runs a GW3-TRBO client. We want to create a role named gw3admin that will serve an administrator role in GW3-TRBO. User Dave will be a member of this group. Dave wants to be able to log into GW3-TRBO from either computer.

These are the steps required to set up this system:

1. In the GW3-TRBO GW_Security module, create the SystemHost\gw3admin and SystemClient\gw3admin roles and assign the desired privileges. **Note that these are two independent roles and their privileges must be maintained separately.**
2. Create the gw3admin security group in Windows on both SystemHost and SystemClient.
3. Assign the gw3admin role to Windows user Dave on both SystemHost and SystemClient.
4. In the SQL instance, add SystemHost\gw3admin as a login.
5. Map SystemHost\gw3admin to databases GW and KPI using role db_gw3user.

The first time Dave logs into GW3-TRBO from a computer, \<computer_name>\Dave will be auto-created in the SEC_Users table with a role of \<computer_name>\gw3admin. If Dave logs in from another computer, the role will be updated to the new computer name.

⚠️ **A user's permissions could vary based on which machine they use to log into GW3-TRBO if the roles are not maintained consistently for each machine.**

⚠️ Be careful not to assign multiple security groups used in GW3-TRBO to your Windows users: Windows users logging into GW3-TRBO must have exactly one security group that exists as a role in the SEC_Roles table. These are matched on \<computer_name>\<name> (i.e. SystemHost\gw3admin is used for the gw3admin security group on computer SystemHost). If there is not exactly one match, the user will be rejected.

⚠️ If the GW3-TRBO databases are owned by a local machine account, that account will not be able to log into GW3-TRBO because its role cannot be changed.
Chapter 4   GW3-TRBO Module GUls Overview

This chapter contains the following sections:

- **What are Module GUls?**: Describes the function of the GW3-TRBO module GUls.
- **Common Module GUI Buttons**: Defines each common module GUI button.
- **Module Connection Displays and Functions**: Defines each button display and function associated with the data stream between the module GUI and the module.
- **Database Incompatibility Warnings**: Describes the database incompatibility warnings issued by GW3-TRBO.
- **Module Help**: Describes the integrated help/manual GUls that can be accessed from any GW3-TRBO module GUI.

**What are Module GUls?**

GW3-TRBO provides a GUI for each of its modules. Each module GUI differs in its purpose and its interaction with its module. Some module GUls simply provide a setup interface for the module, such as the Archiver GUI. Some module GUls show input packet traffic such as Activity or statistics such as SysSummary.

Although each GUI looks and behaves differently, all GUls share some common functionality. This chapter describes these common functions.

**Common Module GUI Buttons**

Many of the buttons in GW3-TRBO use icons common to all its GUls. These buttons perform the following actions:

- **＋**: The Add button allows you to add items such as connections in various GW3-TRBO modules.
- **⁻**: The Delete button allows you to remove items such as connections in various GW3-TRBO modules.
- ** سيتم**: The Save button will save the item being edited.
- ** سيتم**: The Options button will allow the user to configure additional options for a module or targeted item.
- ** سيتم**: The Edit button allows a user to edit an item.
- ** سيتم**: The Previous button is used to navigate to the previous item or page.
- ** سيتم**: The Next button is used to navigate to the next item or page.
- ** سيتم**: The Refresh button is used to retrieve a fresh copy of an item or items from a data source.
- ** سيتم**: The Browse button allows users to choose an item such as a color, file location or talkgroup from a list.
• The Clear button will reset the values on a form.
• The History button will display a list of historical events for the targeted item.
• The Cancel button cancels the edit in progress.

**Module Connection Displays and Functions**

Each module GUI must maintain a constant connection with its respective module. This connection is used to:

- Allow the module to pass data to the module GUI, such as:
  - Licensing information.
  - Real-time data.
  - Global GW3-TRBO notifications, such as Alias or Security updates or Trigger events.
- Notify the module when settings or options are changed in the module GUI.

Each module GUI contains:

- Module Status box: Displays the current connection status.

**Figure 4.1 – Module Status box**

Connected to Module: Yes
Default Module Ports

Each GW3-TRBO module has a distinct port number that it uses to communicate with its GUI. The table below shows each module’s default port number:

<table>
<thead>
<tr>
<th>Module</th>
<th>Default Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launch</td>
<td>10300</td>
</tr>
<tr>
<td>Alerts</td>
<td>10301</td>
</tr>
<tr>
<td>Activity</td>
<td>10320</td>
</tr>
<tr>
<td>Archiver</td>
<td>10321</td>
</tr>
<tr>
<td>SysLog</td>
<td>10323</td>
</tr>
<tr>
<td>Alias</td>
<td>10324</td>
</tr>
<tr>
<td>Group</td>
<td>10325</td>
</tr>
<tr>
<td>Channel</td>
<td>10326</td>
</tr>
<tr>
<td>SysSummary</td>
<td>10327</td>
</tr>
<tr>
<td>Affiliation</td>
<td>10328</td>
</tr>
<tr>
<td>SAM</td>
<td>10329</td>
</tr>
<tr>
<td>GenSPOut</td>
<td>10330</td>
</tr>
<tr>
<td>Location</td>
<td>10331</td>
</tr>
<tr>
<td>Security</td>
<td>10332</td>
</tr>
<tr>
<td>SysVista</td>
<td>10333</td>
</tr>
<tr>
<td>Trigger</td>
<td>10338</td>
</tr>
<tr>
<td>Halcyon</td>
<td>10339</td>
</tr>
<tr>
<td>Reports</td>
<td>10342</td>
</tr>
<tr>
<td>GEnSAC</td>
<td>10344</td>
</tr>
<tr>
<td>Trbo</td>
<td>10348</td>
</tr>
<tr>
<td>Trio</td>
<td>10350</td>
</tr>
<tr>
<td>Connect</td>
<td>10349</td>
</tr>
<tr>
<td>APM</td>
<td>10353</td>
</tr>
<tr>
<td>KPI</td>
<td>10354</td>
</tr>
<tr>
<td>SystemMap</td>
<td>10355</td>
</tr>
</tbody>
</table>

Table 4.1 – GW3-TRBO Module Default TCP/IP Ports

Changing a Module’s Default Port

The default port for each module is shown in the table above. You can change these ports if they conflict with another application attempting to use the same ports. To change the module port, contact GW3-TRBO support.

⚠️ Changing a port may void your warranty. If you feel you need to change a module port, please contact GW3-TRBO support.
**Database Incompatibility Warnings**

When a GUI loads, it checks its version against the version of the GW3-TRBO database used by the GW3-TRBO host. If there is a difference between versions or either version could not be determined, the GUI shows a warning like the one below.

![Database Incompatibility Warning](image)

**Figure 4.2 – Database Incompatibility Warning**

This warning commonly results from a GW3-TRBO client installation using a different version than the GW3-TRBO host installation. If you see this warning, please contact your system administrator or Genesis support.
Module Help

GW3-TRBO has an integrated help system in the event that you need help for any part of GW3-TRBO. Each module has its own help manual that can be easily accessed from within the module’s GUI. To show the help manual for a specific module, load that GUI and press the F1 key. This will display the help manual in the GW3-TRBO Help Viewer as shown below.

![GW3-TRBO Help Viewer](image)

**Figure 4.3 – GW3-TRBO Help Viewer**

In the GW3-TRBO Help Viewer, you can navigate throughout the manual. A Table of Contents appears near the start of the manual, allowing quick navigation to through the manual.

In many cases, GW3-TRBO will automatically navigate within the manual to display the section which pertains to the part of the GUI directly under the mouse cursor. For example, in the Activity module GUI, if you press F1 while the mouse hovers over the Packet Types list in that GUI, the GW3-TRBO Help Viewer will load the Activity manual and automatically navigate to the Packet Types section of the manual.
This chapter contains the following sections:

- **What is Alerts?**: Describes the Alerts application and its role in the GW3-TRBO solution.
- **Logging into Alerts**: Describes the GW3-TRBO login window as provided by Alerts.
- **Alerts Menu**: Describes the use of the Alerts menu.
- **Alerts Connection Icons**: Describes the types of icons shown by Alerts and how to interpret and/or interact with them.
- **Alerts Notification Windows**: Describes the Notification Window feature provided by Alerts.
- **Alerts Emergency Display**: Describes the Emergency Display window.

### What is Alerts?

Alerts is a System Tray application. This means that this application does not display a GUI. Instead, it shows an icon in the Windows System Tray (the bottom-right area of your desktop next to the clock). Alerts will show one of the following icons:

- ![Icon](image)
  - This icon indicates that the Alerts application is running and is currently connected to the GW3-TRBO service.
- ![Icon](image)
  - This icon indicates that the Alerts application is running but is not currently connected to the GW3-TRBO service.

If you do not see either of these icons, you may need to start Alerts. To start Alerts, take the following steps:

1. Click on the Windows Start button.
2. Click on All Programs (or Programs in some versions of Windows).
3. Click on Startup.
4. Click the GW3-TRBO icon ![Launch](image). This will load Alerts and show the login window.

### Logging into Alerts

The GW3-TRBO Installer places a shortcut to Alerts in the Startup folder of your Windows Start menu. This means that when Windows starts up (after reboot, power off, etc.), it loads Alerts automatically. After Alerts loads, the Login window will appear:
The *Login* window contains the following options:

- **Authentication**: Type of authentication used to log into GW3-TRBO. Options include Genesis and Windows.
- **Username**: GW3-TRBO username you wish to log in with. This box will contain the username that last logged in on this machine. If this is your first time logging in, use **Admin**.
- **Password**: Password of the GW3-TRBO user entered in **Username**.
- **Enter the Host machine name**: Name of the machine that is running the GW3-TRBO service. This drop-down list will contain the names of all previous host machines used on this machine.
- **Cancel**: Click this button to cancel login and close Alerts.
- **Login**: Click this button once you have entered or verified the **Authentication**, **Username**, **Password**, and **Host machine name**.
- **Advanced**: Shows / Hides the **Enter the Host machine name** option.

GW3-TRBO uses your login information provided in this login window for Launch and all other GW3-TRBO GUIs. In Launch, click the **Switch User** item under the **File** menu to log in as a different user or to log into a different GW3-TRBO host.

GW3-TRBO users are limited to a single Alerts session. If you attempt to use a GW3-TRBO user to log into Alerts from multiple machines, GW3-TRBO will reject each attempt beyond the first.

Accounts are stored in SQL Server and may be locked out if a user tries to log in with an incorrect password too many times. SQL Server uses domain settings to determine the number of failed logins allowed before the account is locked out and the duration of the lockout. SQL Server does not report the reason a login attempt was rejected to the client for security reasons. A SQL Server administrator can determine if an account is locked out and unlock it. See SQL Server documentation for this procedure.
If an administrator requires users to agree to a policy statement before logging in, the statement will open in a new window after the user clicks the **Login** button. The user must click the **I Agree** button to proceed with the login.

![GW3-TRBO Security Warning Banner](image)

**Figure 5.2** – GW3-TRBO Security Warning Banner

**Password Expiration**

Passwords for GW3-TRBO logins are stored in the Microsoft SQL Server instance that hosts the GW3-TRBO database. Password expiration is based on your local security policy or domain security policy if the GW3-TRBO host is a member of a domain.

If passwords are set to expire, Alerts will show how many days remain until the logged-in user's password expires.

If the user's password has expired and requires a change, Alerts will present a Change Password window upon login. Use this window to change the password of the user that is attempting to log in.

**Alerts Menu**

The Alerts menu appears when you right-click on the Alerts icon. This menu contains the following options:

- **Launch**: Loads the Launch application.
- **Modules**: Displays a list of shortcuts to licensed modules. Click to open a module directly.
- **Tools**: Displays list of shortcuts to Tools configured in Launch.
- **Emergencies**: Provides access to the Emergency Display window.
  - **Show**: Displays the Emergency window.
  - **Show on Emergency**: “Arms” the emergency window so that it is displayed when an emergency event occurs.
Close All Modules: Closes all open GW3-TRBO windows except for Launch.
Exit: Closes Alerts.

If Alerts is closed, you will not receive GW3-TRBO Notifications. Also, the connection icons will not show. Genesis recommends that you never close Alerts.

**Alerts Connection Icons**

The above section described the Alerts icons that show the running and connected state of Alerts. Additionally, Alerts will show an icon in the System Tray for each active (enabled) connection in each GW3-TRBO input module. For example, if your Trbo module has two active connections, Alerts will show two connection icons.

Connection icons show one of the following states:

- ✗: Connection is encountering an error.
- ✖: Connection with a connected client is encountering an error.
- ✤: Connection has received packets within the past several seconds. The amount of time varies by connection type.
- ✦: Connection with a connected client has received packets within the past several seconds. The amount of time varies by connection type.
- ◆: Connection has not received packets within the past several seconds. The amount of time varies by connection type. (Blinks between red and white background.)
- 🚭: Connection with a connected client has not received packets within the past several seconds. The amount of time varies by connection type. (Blinks between red and white background.)
- 🟢: Connection that manages multiple data sources is receiving data from at least one source, but at least one other source is either not receiving data or has a connectivity issue.

Move the mouse over a connection icon to see its connection type, name and status.

**Alerts Notification Windows**

Notifications come in many forms. They can range from a Link Down notification from an input module (indicating that the data stream is down) to an Unattended Emergency Alarm (sent by Halcyon indicating that an emergency alarm was not delivered to a dispatcher). No matter what the flavor, these notifications are displayed in the GW3-TRBO Notification window via Alerts.

See *Chapter 11 - GW3-TRBO Notifications* for more information on the GW3-TRBO Notification window.
Alerts Emergency Display

The Emergency Display window provides direct information about emergency events on the system. The list font can be changed through the options menu.

![Emergency Display](image)

**Figure 5.3 – Emergency Display**

The emergency window contains the following columns. **Bold** items are updated with new activity from the emergency unit.

- **Timestamp**: Displays the time of the initial emergency alarm.
- **Radio**: Displays the ID and alias of the unit in an emergency state.
- **EA Group**: Displays the group received in the emergency alarm packet.
- **Current Group**: Displays the group to which the radio is currently affiliated.
- **Previous Group**: Displays the group the radio was affiliated to prior to the emergency alarm.
- **Default Group**: Displays the default group selected in alias.
- **Last Activity**: Displays the time of the last received activity.
- **Site**: Displays the site on which the radio is currently affiliated.
- **Zone**: Displays the zone involved.
- **WACN:System**: Displays the WACN:System involved.

Access the Emergency Display by right-clicking the Alert icon and select one of the following options under the **Emergencies** submenu:

- **Show** to display the emergency window
- **Show on Emergency** to display the emergency window when an emergency event occurs.

![Emergencies Submenu](image)

**Figure 5.4 – Emergencies submenu**
Removing emergency messages

Emergency messages can be cleared by right-clicking on an emergency and choosing an option from the Emergency Context Menu.

- **Delete** removes the currently selected emergency.
- **Clear All** to remove all emergencies.

![Emergency Context Menu]

**Figure 5.5** – Emergency Context Menu

Emergencies will be displayed for users that have the Security *Administrator* privilege or have the emergency’s Group or Agency and Location in Security’s User Filter.
This chapter contains the following sections:

- **Viewing Real-time Module Status**: Describes how to view and understand the *Modules* list and the *Info* section.
- **Creating Module Notes**: Describes how to create and view module notes.
- **Loading Module GUIs**: Describes how to load the module GUI for a specified module.
- **Loading the GW3-TRBO License Manager**: Describes how to load the GW3-TRBO License Manager window.
- **Creating Shortcuts to Useful Tools**: Describes how to create shortcuts within Launch to the applications that you use the most.
- **Setting Up a Temporary Filter for Real-Time Activity Modules**: Describes how to create a filter that will affect multiple GUIs for a limited time.
- **Changing Global Settings**: Describes how to further customize GW3-TRBO.

![Launch GUI](image-url)  
*Figure 6.1 – Launch GUI*
**Viewing Real-time Module Status**

Launch allows you to view module activities and statuses for the selected module icon. This status is shown on the right side of the menu bar. It shows:

- **Module Name**: Shows the selected module’s name.
- **Status**: Shows the selected module’s overall status at the time it was selected. Module statuses include:
  - **File Not Found or Not a DLL**: GW3-TRBO module file is missing or corrupt.
  - **Invalid DLL**: GW3-TRBO module file does not satisfy the installed version of the module interface.
  - **Not Licensed**: GW3-TRBO license does not include this module.
  - **Expired**: Evaluation/lease period has expired.
  - **Starting**: The GW3-TRBO service is starting the module.
  - **Started**: The module is started (currently processing).
  - **Stopping**: The GW3-TRBO service is stopping the module.
  - **Stopped**: The module is currently stopped (not processing).

**Modules List Menu**

To view the Modules menu, right-click on the Modules list. The Modules menu includes the following options:

- **Open Interface**: Opens the selected module’s GUI.
- **Show Quick Launch**: Shows all module icons in the Product Sheet section of Launch.
- **Show Module Product Sheets**: Shows the product sheet of the selected module in the Product Sheet section of Launch.
- **Refresh Modules**: Refreshes the Modules list and the status of all modules.
- **Temporary Filter**: Opens a window to set up a temporary filter for real-time activity modules.
- **Global Settings**: Opens a window to change GW3-TRBO options for the current user, such as the unit of measure displayed.

**Creating Module Notes**

Launch allows you to make PC-specific notes for each GW3-TRBO module. PC-specific means that each user who uses Launch on this machine will see these notes. These notes allow you to:

- Leave a module-related note for the next user.
- Provide yourself with additional information about the module.

To create module notes, take the following steps:

1. Hover the mouse over the slider to the right of the modules list. This will show a slider adjustment icon.
2. Click and hold and move the slider to the right, exposing the **Notes** section.
3. Select the module for which you wish to make notes.
4. Type the notes in the Notes section.

**Loading GUIs**
Launch provides a portal (central location) for launching the GUIs. To launch a GUI, take the following steps:
1. Find the icon of the module that you wish to launch in the Modules list.
2. Double-click on the module icon. This will load the module GUI for the module that you double-clicked.

**Load the GW3-TRBO License Manager**
Launch provides an entry point into the GW3-TRBO License Manager if you are running Launch from the GW3-TRBO server machine. To load License Manager, click in the View License option in the Help menu. This will load GW3-TRBO License Manager.

You can read more in Chapter 7 - GW3-TRBO License Manager.

**Creating Shortcuts to Useful Tools**
Launch provides a handy feature that allows you to easily link to other files or programs on your machine. For instance, if you commonly run Notepad or Excel, you can add them to Launch as “Tools” and then start them from within the Launch Tools window. The Tools window is found below the Modules list and will already contain a link to GW3-TRBO help.

Clicking the help link will launch the help page with the program assigned to open .htm files in Windows.

To add a tool to Launch, perform the following steps:
1. Click the Add Tool item under the Options menu. This will open the Add Tool window shown below.
2. Enter or browse to the location of the file to be added to the tools.
3. A tool name will be populated based off the name if a file is selected. Edit the name of the tool if desired or enter a name if the location was entered manually.

![Add Tool](image)

**Figure 6.2 – Add Tool**
Below is a sample of what your Tools window might look like if you added Microsoft Notepad and Microsoft Calculator:

![Tools Window](image)

**Figure 6.3 - Tools**

Setting Up a Temporary Filter for Real-Time Activity Modules

Launch allows you to create a filter that will affect the Activity, Channel and Group modules for a specified amount of time. This allows you to quickly narrow your focus down to a specific set of radio IDs or talkgroups without having to manually disable the filter later.

To create a temporary filter, perform the following steps:

1. Open the Modules menu by right-clicking in the modules box. Select Temporary Filter; this will open the Temporary Filter window.
2. Check the Enable Temporary Filter box. This will allow you to edit the filter settings.
3. From the Filter Type drop-down box, choose the type of resource you’d like to filter on.
4. Specify a duration for the filter on the Duration control. Setting a duration of zero will cause the filter to last until manually disabled using this window.
5. Click the button to add resources to your filter list.
6. From the selector window, you can search your Alias database for resources based on a variety of properties or leave the fields blank to return all resources of that type. Click Search to see the list of resources that meet your criteria.
7. Select the resources you would like to be able to see on the real-time activity modules, then click OK. Activity from resources that are not selected will not be visible on Activity, Channel or Group, but that activity will still be archived to your database.
8. To remove a single resource, highlight the resource and click the button.
9. To remove all resources from the filter, click the button.
10. Click the **OK** button on the *Temporary Filter* window. This will activate the filter and start its timer. A timer showing the remaining time will be displayed on Launch.

![Figure 6.4 – Temporary Filter and Filter time remaining](image)

To manually disable a temporary filter, perform the following steps:

1. Click the **Temporary Filter** button in the Modules menu. This will open the *Temporary Filter* window. You can also open this window by double-clicking the filter timer on the bottom-right corner of the Launch GUI.
2. Uncheck the **Enable Temporary Filter** box.
3. Click **OK**. The filter will be disabled.

If no resources are added to a filter the filter will be disabled when the user attempts to apply the filter.

**Changing Global Settings**

Launch allows each GW3-TRBO user to specify preferences that will be applied to every applicable module GUI. Changing a global setting on one user will not affect the global settings used by any other user.

To change the global settings, right-click in the Modules list to bring up the Modules menu. Select **Global Settings** to open the *Global Settings* window.

![Figure 6.5 – Global Settings Window](image)
The following options can be changed:

- **Unit of Measure:** This specifies whether measurements displayed in GW3-TRBO should use imperial or metric units. This is used in several module GUIs to display distances in either miles or kilometers.

- **Coordinate Format:** This specifies the format to be used when displaying geographic coordinates, such as those provided by GPS systems. The options are:
  - **Decimal Degrees:** Formats coordinates like 32.305108
  - **Degree Minutes Seconds:** Formats coordinates like \(32^\circ 18' 18.389''\)

- **System ID Format:** This specifies whether system IDs should be displayed to the current user as hexadecimal or decimal numbers in the GW3-TRBO GUIs and reports. Regardless of the choice made here, system IDs will always appear in your license and database as the hexadecimal number.
Chapter 7  
GW3-TRBO License Manager

This chapter contains the following sections:

- **Do I Need to Activate My License?**: Describes scenarios that would not require you to activate your GW3-TRBO license.
- **What is the GW3-TRBO License?**: Describes the function and role of the GW3-TRBO license.
- **Loading GW3-TRBO License Viewer**: Describes how to load the GW3-TRBO License Viewer.
- **License Details**: Describes the information shown in the GW3-TRBO License Viewer.
- **License Manager Options**: Describes the function of each option above the License Details.

**Do I Need to Activate My License?**

Some installs come pre-installed on a GW3-TRBO machine (PC). These installs have an activated license. The activation steps defined in this chapter are not necessary for these installs.

If your GW3-TRBO computer was not shipped to you from The Genesis Group or staged by a third party, you will need to go through the activate license process described below.

In short, if the Activate Product(s) window greets you when you load Alerts, you need to activate your license.

**What is the GW3-TRBO License?**

The GW3-TRBO license allows you to customize your GW3-TRBO installation by selecting from various GW3-TRBO product packages. The GW3-TRBO license also protects your software from piracy and illegal distribution. GW3-TRBO licensing exists within the GW3-TRBO service, each module, and in some module GUIs. The GW3-TRBO License Viewer shows all licensing information for GW3-TRBO, including each licensed module.
**Loading GW3-TRBO License Viewer**

To load *GW3-TRBO License Viewer*, take the following steps:

1. Load GW3-TRBO Launch.
2. Click on the **View License** item under the **Help** menu. This will load the **GW3-TRBO License Viewer**.

![Image of GW3-TRBO License Viewer](image)

**Figure 7.1** – GW3-TRBO License Viewer

The GW3-TRBO service (the behind-the-scenes application that runs the GW3-TRBO modules) is licensed for a specific machine. If a GW3-TRBO machine changes drastically, your license will become invalid and you must contact GW3-TRBO support to obtain a new license. Changes such as replacing a hard drive or upgrading the operating system will invalidate the license.
**License Details**

The License Details tree shows detailed information regarding your activated GW3-TRBO license. The major sections include:

- **Version**: Licensed GW3-TRBO version.
- **Package**: GW3-TRBO package purchased.
- **CustomerName**: Customer this license is registered to.
- **PurchasedFrom**: Company you purchased this license through.
- **RegistrationNumber**: Generally, the purchase order for this license.
- **Branding**: Branding option. This is usually TRBO.
- **StartDate**: The date/time this license was issued.
- **LastContact**: Last modification made to this license.
- **WACNS**: The topmost tier of the licensed infrastructure. This infrastructure will contain at least one licensed system.
- **Modules**: Contains an entry for each licensed module. Each module contains a Restrictions section, with an entry for each of its specific license features.

**License Manager Options**

**Activate Product(s)**

This option opens the Activate Product(s) window. This window is used to evaluate the GW3-TRBO product or to activate GW3-TRBO after you have purchased a license.

![Activate Product(s) Window](image)

**Figure 7.2** – Activate Product(s) Window
The Activate Product(s) window contains the following options:

- **Browse to licenseupdate.lic file**: Click this button to show the *Open File* dialog box. This dialog box allows you to browse your local and network machine for the GW3-TRBO license file.
- **Continue**: Click this button to close the Activate Product(s) window. This button is only available if your GW3-TRBO installation is licensed.
- **X**: Click this button to close the Activate Product(s) window. If your GW3-TRBO is not licensed, this will also close Alerts.

If your GW3-TRBO installation was not licensed by your vendor, GW3-TRBO shows the Activate Product(s) window when you run Alerts. This is our way of telling you that your GW3-TRBO installation is not licensed.

To activate your purchased GW3-TRBO license, take the following steps:

1. Select the ENTIRE code in the Request Code box.
2. Right-click on the selected code. This will show an edit pop-up menu with options including **Copy**.
3. Choose **Copy** from the edit pop-up menu.
4. Open your email application and create a new email to *Support@GenesisWorld.com*
5. Right-click in the body of the email. This will show an edit pop-up menu with options including **Paste**.
6. Choose **Paste** from the edit pop-up menu. This will paste your Request Code into the email exactly as it was on the Activate Product(s) window.
7. Also include in the email your company name and your contact information.
8. Send the email.
9. Contact GW3-TRBO support (see the Support section of this manual). The support person will assist you with the rest of the activation process.

The result of this license request is a license file, usually named licenseupdate.lic. Use the **Browse to licenseupdate.lic file** button (described above) to select the license file and click **OK**. This will send the file to the GW3-TRBO service and update the GW3-TRBO license.

Updating the GW3-TRBO license results in a GW3-TRBO Notification window (described in *Chapter 11 - GW3-TRBO Notifications*), warning you and all other administrator-level GW3-TRBO clients that a GW3-TRBO user has updated the license. If you are activating the initial license for GW3-TRBO, this will also enable the **Continue** button.
Refresh License

This option queries the GW3-TRBO service for the current license. The License Viewer shows the results of the query.

If no email is available at the installation site, the person performing the install will need to run Launch, get the activation code, physically go to a location that does have access to email, request the activation file from Genesis, copy the activation file provided by Genesis to some form of removable media (CD, Disk, Flash drive, etc.), bring the file back to the installation site, and place it in the GW3-TRBO installation directory.

Deactivate License

If you need to move your GW3-TRBO host to a different machine, you will need to deactivate the license on the current host. The Deactivate License button results in a GW3-TRBO Unlock Code window. You must contact GW3-TRBO support in order to receive an unlock code.

Once you enter the unlock code, you will receive a dialog box showing the deactivation confirmation code. This code is provided to GW3-TRBO support to confirm that the license has been deactivated.

The Deactivate License option is only available to users with the Security Administrator privilege.
Chapter 8  Security Module GUI

This chapter contains the following sections:

- **What is Security?**: Describes the role of security within GW3-TRBO.
- **Privileges**: Describes the function of privileges.
- **Roles**: Describes the function of roles and how to maintain them.
- **Users**: Describes the function of users and how to maintain them.
- **Activity History**: Describes how to view the user activity history view.
- **Current Users**: Describes how to view the list of current users.

**What is Security?**

In GW3-TRBO, security refers to the different functions and data filters that you can allow or disallow on a per-module-per-user basis. GW3-TRBO applies these security options to each user when they log into Launch. They are carried over to each GUI or tool that this user launches within Launch. The security properties within Security are made up of three entities:

- **Privileges**: Predefined allowances for actions and view rights within the GW3-TRBO module GUIs. Privileges exist on a per-module basis.
- **Roles**: Used to describe and house a group of privileges.
- **Users**: Used to define the people who use the GW3-TRBO module GUIs. Users are assigned a role and a list of groups which they can view (Unconditional access to all groups is a role privilege granted on a module-by-module basis).

![Security GUI](image)

**Figure 8.1** – Security GUI
Privileges

Privileges are predefined module-level allowances for actions and view rights within a GW3-TRBO GUI. Each module contains a set of predefined privileges. Privileges are assigned to roles; therefore, a user who is assigned a role inherits that role’s privileges.

Privileges List

Table 8.1 shows each module and its predefined privileges:

<table>
<thead>
<tr>
<th>Module</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>ViewAllAgencies</td>
<td>Ignores user-level agency filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllGroups</td>
<td>Ignores user-level group filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllSites</td>
<td>Ignores user-level site filters.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affiliation</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>ViewAllAgencies</td>
<td>Ignores user-level agency filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllGroups</td>
<td>Ignores user-level group filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllSites</td>
<td>Ignores user-level site filters.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Allows the user to delete existing resources.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td>Allows the user to update existing resources.</td>
</tr>
<tr>
<td></td>
<td>Import</td>
<td>Allows the user to import and add resources.</td>
</tr>
<tr>
<td></td>
<td>Resynchronize</td>
<td>Allows the user to request the module to resynchronize its alias list with the alias database.</td>
</tr>
<tr>
<td></td>
<td>ViewAllGroups</td>
<td>Used to grant administrative access to all IDs/groups for users selected in Trigger.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APM</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>ViewAllSites</td>
<td>Ignores user-level site filters.</td>
</tr>
</tbody>
</table>

Table 8.1 – Module Privileges
<table>
<thead>
<tr>
<th>Module</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archiver</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td>Allows the user to update archiving options.</td>
</tr>
<tr>
<td>Channel</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>ViewAllAgencies</td>
<td>Ignores user-level agency filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllGroups</td>
<td>Ignores user-level group filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllSites</td>
<td>Ignores user-level site filters.</td>
</tr>
<tr>
<td>Connect</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td>Allows the user to add, update, and delete connections.</td>
</tr>
<tr>
<td>GEnSAC</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td>GenSPOut</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td>Allows the user to add, update, and delete all settings.</td>
</tr>
<tr>
<td>Group</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>ViewAllAgencies</td>
<td>Ignores user-level agency filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllGroups</td>
<td>Ignores user-level group filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllSites</td>
<td>Ignores user-level site filters.</td>
</tr>
</tbody>
</table>

Table 8.1 – Module Privileges (cont.)
<table>
<thead>
<tr>
<th>Module</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Halcyon</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td>Call Alert</td>
<td></td>
<td>Allows the user to issue Call Alerts.</td>
</tr>
<tr>
<td>Database Snapshot</td>
<td></td>
<td>Allows the user to issue Database Snapshots.</td>
</tr>
<tr>
<td>Emergency Alarm</td>
<td></td>
<td>Allows the user to monitor Emergency Alarm events.</td>
</tr>
<tr>
<td>IP Console Inhibit</td>
<td></td>
<td>Allows the user to issue IP Console Inhibits.</td>
</tr>
<tr>
<td>Radio Check</td>
<td></td>
<td>Allows the user to issue Radio Checks.</td>
</tr>
<tr>
<td>Radio Kill</td>
<td></td>
<td>Allows the user to issue Radio Kills.</td>
</tr>
<tr>
<td>Repeater Disable</td>
<td></td>
<td>Allows the user to issue Repeater Disables and Repeater Enables.</td>
</tr>
<tr>
<td>Selective Inhibit</td>
<td></td>
<td>Allows the user to issue Selective Inhibits.</td>
</tr>
<tr>
<td>Slot Disable</td>
<td></td>
<td>Allows the user to issue Slot Disable commands. The affected radio may also be issued an IP Console Inhibit command and can only be reverted by a user with the IP Console Inhibit privilege. Therefore, it is advisable but not required to grant the IP Console Inhibit privilege to users with the Slot Disable privilege.</td>
</tr>
<tr>
<td>Unattended Emergency Alarm</td>
<td></td>
<td>Allows the user to receive Emergency Alarms that fail to be delivered to a connected RC user.</td>
</tr>
<tr>
<td>ViewAllAgencies</td>
<td></td>
<td>Ignores user-level agency filters.</td>
</tr>
<tr>
<td>ViewAllGroups</td>
<td></td>
<td>Ignores user-level group filters.</td>
</tr>
<tr>
<td>ViewAllSites</td>
<td></td>
<td>Ignores user-level site filters.</td>
</tr>
</tbody>
</table>

Table 8.1 – Module Privileges (cont.)
<table>
<thead>
<tr>
<th>Module</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>ViewAll Agencies</td>
<td>Ignores user-level agency filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllGroups</td>
<td>Ignores user-level group filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllSites</td>
<td>Ignores user-level site filters.</td>
</tr>
<tr>
<td>SAM</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td>Security</td>
<td>Access</td>
<td>Allows the user to access this module’s window.</td>
</tr>
<tr>
<td></td>
<td>Administrator</td>
<td>Allows the user Administrator access to GW3-TRBO.</td>
</tr>
<tr>
<td></td>
<td>ChangePassword</td>
<td>Allows the user to change passwords. If combined with ManageUsers, then the user can change the password of any user. Otherwise, the logged-in user can only change his/her password.</td>
</tr>
<tr>
<td></td>
<td>ManageRoles</td>
<td>Allows the user to add, update, and delete roles. If not given, then the user has view-only access to the role assigned to him/her.</td>
</tr>
<tr>
<td></td>
<td>ManageUsers</td>
<td>Allows the user to add, update, and delete users. If not given, then the user has view-only access to their own user properties.</td>
</tr>
<tr>
<td></td>
<td>ViewCurrentUsers</td>
<td>Allows the user to view the list of currently logged-on users.</td>
</tr>
<tr>
<td></td>
<td>ViewUserActivity</td>
<td>Allows the user to see other users’ activity. If not given, the user can only see their own activity.</td>
</tr>
</tbody>
</table>

*Only users with the Administrator role will be able to see other users with the Administrator role.*

<table>
<thead>
<tr>
<th>Module</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SysLog</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td>Allows the user to add, update, and delete connections.</td>
</tr>
<tr>
<td>SysSummary</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
</tbody>
</table>

Table 8.1 – Module Privileges (cont.)
<table>
<thead>
<tr>
<th>Module</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SystemMap</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>ViewAllGroups</td>
<td>Ignores user-level group filters.</td>
</tr>
<tr>
<td>SysVista</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td>Trbo</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td>Allows the user to add, update, and delete connections.</td>
</tr>
<tr>
<td></td>
<td>Setup Filters</td>
<td>Allows the user to edit the filter settings for each connection.</td>
</tr>
<tr>
<td></td>
<td>ViewAllAgencies</td>
<td>Ignores user-level agency filters.</td>
</tr>
<tr>
<td></td>
<td>ViewAllGroups</td>
<td>Ignores user-level group filters.</td>
</tr>
<tr>
<td>Trigger</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td>Module</td>
<td>Privilege</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Trio</td>
<td>Access</td>
<td>Allows the user to access this module’s GUI.</td>
</tr>
<tr>
<td></td>
<td>Add</td>
<td>Allows the user to add new records via the various Trio data entry windows.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td>Allows the user to edit records via the various Trio data entry windows.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Allows the user to delete records via the various Trio data entry windows.</td>
</tr>
<tr>
<td></td>
<td>Post</td>
<td>Allows the user to perform other operations that affect billing such as posting documents, running invoices, etc.</td>
</tr>
</tbody>
</table>

*You will see Role Privilege options for these features even if you are not licensed for these features.

The Edit privilege is required to commit changes within the module. A user without this privilege may be able to change values within a module; however, they will not be able to save them. If a module does not have an Edit privilege, the Access privilege will allow updates.

Some privileges appear in the security module that are not listed. These privileges do not affect the functionality of this version of GW3-TRBO.

**Security for Windows Authentication**

If you are using Windows Authentication for your GW3-TRBO logins, make sure to read the *Staging for Windows Authentication* section of this document before setting up roles and users in Security.
Roles

Roles are used to describe and house a set of privileges. A role is assigned to a user. This assigns the role’s privileges to the user. Typical roles include:

- **Dispatcher**: User has access to all real-time activity GUIs, but no configuration GUIs.
- **Reporter**: User only has access to the Reports module.

![Security User Management GUI](image)

Figure 8.2 – Security User Management GUI

The modules that appear in the Role Privileges list are determined by the license used to activate the software and may differ from screenshots provided in this document.

Adding a New Role

To add a new role, you must be logged into GW3-TRBO with a user that includes the ManageRoles privilege in its role. To add a new role, follow the steps below:

1. Load the Security GUI.
2. Select Roles on the View menu. This will show the role management section of the Security GUI.
3. Click the Add New button. This will clear Role Name box.
4. Enter a role name that is not already in use.
5. Under each module, check each Role Privilege you want to include in this role and uncheck any Role Privilege that you do not want included. Clicking the checkbox next to the module name will select and unselect all role privileges under the module.
6. Click the Update button.
Editing a Role

To edit an existing role, you must be logged into GW3-TRBO with a user that includes the ManageRoles privilege in its role. To edit an existing role, follow the steps below:

1. Load the Security GUI.
2. Select Roles on the View menu. This will show the role management section of the Security GUI.
3. Click on the role in the Roles list that you wish to edit.
4. Change the Privileges assigned to this role.
5. Click the Update button.

Deleting a Role

To delete an existing role, you must be logged into GW3-TRBO with a user that includes the ManageRoles privilege in its role. Roles can only be deleted if they are not assigned to a user. To delete an existing role, follow the steps below:

1. Load the Security GUI.
2. Select Roles on the View menu. This will show the role management section of the Security GUI.
3. Click on the role in the Roles list that you wish to delete.
4. Click the Remove Button or right-click on the role in the Roles list that you wish to delete to show a menu of role options, including Remove.
   This will result in a confirmation dialog.
5. Click Yes to remove the role.

If a user does not have the Security ManageRoles privilege, the user can view the privileges of his/her own role but not the privileges of any other roles.

Role names cannot begin or end with a space and each character must be in the range of ASCII 0-255, excluding the following characters:
/ \ [ ] : ; = + * ? < > " , @ { } ( ) . ` & % $ !

Users

Users define the people who use the GW3-TRBO software. Users are assigned a role and a list of groups, agencies and sites which they can view. (Unconditional access to all groups, agencies and sites are privileges.) You provide a username when you log into GW3-TRBO Launch. This username is passed to each of the GW3-TRBO GUIs as it is loaded. Each GUI examines the privileges assigned to the user’s role to determine the view and edit rights for the given user. Based on these privileges, the GW3-TRBO GUI will limit the data and functions for the user.

Changes to user privileges are recognized by the GW3-TRBO GUIs in real time. If you are logged into a GUI with edit privileges, and across town the system administrator removes your edit privileges for your current GUI, you will notice some buttons disappear from your GUI. When a user has a GUI open and the
“Access” privilege is removed the module will not be closed, removing the access privilege prevents the user from opening the module in the future. Also if Launchpad is open and the Access privilege is removed from one or more modules the icons will remain until Launchpad is closed and reopened or the user refreshes the modules list, during this time however the user will not be able to open the modules without the Access privilege.

**Figure 8.3** – Security User Properties Window

**The Administrator Role and Admin User**

The GW3-TRBO install includes the Administrator role and the Admin user. This role and user cannot be updated. This user and role represent the administrator user with the administrator role. This role has all privileges available in GW3-TRBO. The only attribute of this user and role that can be changed is the password.

Only Administrator role users can assign the Administrator role to other users. For non-Administrator role users, the Administrator role is not included in the Role list.

**Adding a New User**

To add a new user, you must be logged into GW3-TRBO with a user that includes the ManageUsers privilege in its role. To add a new user, follow the steps below:

1. Load the Security GUI.
2. Select Users on the View menu. This will show the user management section of the Security GUI.
3. Click the Add New button. This will clear and enable the User Name box and show the Password and Confirm boxes.
4. Enter a username that is not already in use.
5. Choose an Authentication Type to determine how the user logs into GW3-TRBO. To login with Windows authentication (i.e. current
Windows user authentication), choose Windows. To login with Genesis authentication (i.e. username and password authentication), choose Genesis.

6. Select a role from the Role list.
7. Choose a **Timeout Idle Sessions** option. If checked, this user is logged out after **Session Idle Timeout** minutes of inactivity within the GW3-TRBO GUIs. Activity includes keyboard input or mouse movement/clicks.
8. If you checked the **Timeout Idle Sessions** option, enter a value for **Session Idle Timeout**. The minimum value is 5 minutes. The maximum value is 1,440 minutes (24 hours).
9. Enter a password for this user in the **Password** box and the **Confirm** box.
10. If you would like for the user to only be able to see certain groups, agencies, sites or message types, modify this in the **User Filter** panel. (see the **User Filters** section below)
11. Click the **Update** button.

There is a limit on password length of 128 characters. Anything beyond this limit will be truncated automatically if pasted into the password field.

**Editing a User**

To edit an existing user, you must be logged into GW3-TRBO with a user that includes the **ManageUsers** privilege in its role. To edit an existing user, follow the steps below:

1. Load the Security GUI.
2. Select **Users** on the **View** menu. This will show the user management section of the Security GUI.
3. Click on the user in the **User Names** list that you wish to edit.
4. If you would like for the user to only be able to see certain agencies, sites or groups, modify this in the **User Filter** panel. (see the **User Filters** section below)
5. Click the **Update** button.

The **Authentication Type** option is not editable.
**Changing a User’s Password**

This option is only available to users with an Authentication Type of Genesis. To change a user’s password, take the following steps:

1. Click on the user in the User Names whose password you wish to change.
2. Click the Change Password button. This will show the Change Password window.
3. Enter the password for the current GW3-TRBO user in the Current Password for <username> box.
4. Enter the user’s new password in the New Password for <username> box and the Confirm new password for <username> box.
5. Press the OK button.

The Security ChangePassword privilege is required to change another user’s password. The logged-in user can change his/her own password without this privilege.

There is a limit on password length of 128 characters. Anything beyond this limit will be truncated automatically if pasted into the password field.

**Deleting a User**

To delete an existing user, you must be logged into GW3-TRBO with a user that includes the ManageUsers privilege in its role. To delete an existing user, follow the steps below:

1. Load the Security GUI.
2. Select Users on the View menu. This will show the user management section of the Security GUI.
3. Click on the user in the User Name list that you wish to delete.
4. Right-click on the user in the User Name list that you wish to delete. This will show a menu of user options, including Remove.
5. Click the Remove option. This will result in a confirmation dialog.
6. Click Yes to remove the user.

Attempting to remove a user that has active processes in SQL Server may not be successful. In this instance the user will be disabled and will be grayed out in the Users → User Names list, the User Properties for the user will have a Remove User button and all other controls will be disabled.

**User Filters**

For users within roles that do not have the ViewAllSites, ViewAllAgencies and/or the ViewAllGroups privilege for each module, the resources that they can view are selected in the User Filter panel in the bottom right.

**Adding Resources**

To add resources to the User Filter:

- Click the Add Filter Resources… button. This will load the resource selector window.
- Enter search criteria and click the Search… button. This will populate the resource list.
• Select one or more resources by clicking the checkbox in the leftmost column. To select all resources in the list, click the Select All button. To unselect all resources in the list, click the Unselect All button.

• Click the OK button. This will close the resource selector window and populate the User Filter with the selected resources.

• Click the User Update button on the User Properties panel. This will save the User Filter changes.

Removing Resources
To remove resources from the User Filter:
• Select the resources in the User Filter. Use Shift + Click to select a range. Use Ctrl + Click to select additional resources.
  o This is standard windows functionality

• Clicking the Remove Filter Resources... button. This results in a confirmation dialog.

• Click Yes on the confirmation dialog. This will remove the selected resources.

• Click the User Update button on the User Properties panel. This will save the User Filter changes.

Editing the Security Warning Banner
The Security GUI allows an administrator to create or edit a security warning banner to be displayed every time a GW3-TRBO user logs in. When the security warning banner is enabled, all users must click a button indicating they agree to the terms defined in the customized banner before they can log in. When disabled, the banner will not be displayed during login attempts.

To edit, enable or disable the security warning banner, take the following steps:
1. Load the Security GUI while logged into GW3-TRBO as a user with the Administrator privilege in Security.
2. Click the Users option in the View menu. This will show the User Properties section of the Security GUI.
3. Click the Edit Security Banner button. This will show the Edit Security Warning Banner window.
4. Enter text into the Header field. This will be used as the title of the window that displays the security warning banner.
5. Enter the text of your banner into the Security Warning Banner Text field. Several basic text formatting tools are provided to change the font, font size, alignment, etc. The field will also preserve formatting if the text is copied and pasted in from a word processor or other rich text editing application.
6. To view how the security warning banner will appear to users, click the Preview button. When done viewing the preview, click the Close button on the new window.
7. To require users to acknowledge the banner before logging in, check the Enable Security Warning Banner checkbox.
8. Press the **OK** button to save your changes or the **Cancel** button to discard any changes. Changes will take effect immediately.

![Edit Security Warning Banner window](image)

**Figure 8.4** – Security Edit Security Warning Banner Window

**Activity History**

GW3-TRBO stores an activity log for each user for no more than 30 days. This information allows you to view the actions of each user. User activity includes the following information per activity entry:

- **Timestamp**: The date and time the activity occurred.
- **Description**: Full description of the activity.
- **Module**: The GW3-TRBO GUI in which the activity occurred.
- **Computer Name**: The computer name on which the activity occurred.
To view user activity for other users, you must be logged into GW3-TRBO with a user that includes the ViewUserActivity privilege in its role. Only users with the Administrator role will be able to see the activity of other users with the Administrator role. Follow the steps below to view user activity:

1. Load the Security GUI.
2. Select Activity History on the View menu. This will show the user activity section of the Security GUI.
3. Select the user for which you want to view activity. This will show the activity for this user for the past 30 days in the User Activity list to the right of the User Names list.

Figure 8.5 – Security Activity History Window
**Login History Snapshot**

Each time you log into GW3-TRBO, Alert will show the last time your user logged in and any failed login attempts between now and your last successful login attempt. This information is also available in the Security Activity History window.

![Login History Snapshot](image)

**Figure 8.6 – Login History Snapshot**

Notifications must be enabled in Windows for this information to appear.

**Current Users**

GW3-TRBO allows you to view the current user information for each user. This information includes the following per user:

- **User Name**: The name of the user.
- **Role**: The role of the user.
- **Logged In**: Shows if the user is currently logged into Alerts.
- **Last Location**: The computer on which this user logged in most recently.
- **Last Activity**: The date and time this user performed one of the following actions:
  - Logging into a GW3-TRBO module GUI.
  - Logging out from a GW3-TRBO module GUI.
  - Performing an administrative function such as adding an input module connection.
  - Being denied access to a GW3-TRBO GUI due to security denial.

Please refer to the **Activity History** for this user to view the details of the last activity entry.

This window does not refresh automatically. To retrieve up-to-date information, click the **Refresh** button.
To view current login states for other users, you must be logged into GW3-TRBO with a user that includes the ViewCurrentUsers privilege in its role. Only users with the Administrator role will be able to see other users with the Administrator role. Follow the steps below to view current login states:

1. Load the Security GUI.
2. Select Current Users on the View menu. This will show the Current Users section of the Security GUI.

![Security Current Users Window](image)

**Figure 8.7 – Security Current Users Window**

If the GW3-TRBO software closes unexpectedly, the currently logged-in user will appear to be logged in until the next time he or she successfully logs out.

**Logging Out a User**

To log out a logged-in GW3-TRBO user, you must be logged into GW3-TRBO with a user that includes the ManageUsers privilege in its role. To log out a logged-in user, follow the steps below:

1. Load the Security GUI.
2. Select Current Users on the View menu. This will show the current user information section of the Security GUI.
3. Click on the user in the User Name list that you wish to log out. Only users that are logged in can be logged out.
4. Right-click on the user in the User Name List.
5. Click the Log Out this User option. This will result in a confirmation dialog.
6. Click Yes to log out the user.

The Admin user cannot be logged out.
This chapter contains the following sections:

- **What is SysLog?**: Describes the role of SysLog within GW3-TRBO.
- **SysLog Packets**: Defines the structure of a SysLog packet.
- **SysLog Connections**: Describes the role of SysLog connections.

### What is SysLog?

SysLog manages SysLog connections. The SysLog module routes events and notifications created by the GW3-TRBO service and modules to each SysLog connection.

![SysLog GUI](image)

**Figure 9.1 – SysLog GUI**

**SysLog**: A de facto standard for forwarding log messages in an IP network. There are several third-party applications (sold by vendors other than The Genesis Group) that can receive, process, store, and issue alarms based on SysLog packets.
SysLog Packets

SysLog is an event format that has been the standard in the UNIX world for many years. SysLog packets are basically ASCII text (letters and numbers), limited to 1024 characters, in which the information in the text follows the SysLog format. Some information in SysLog packets is optional, such as date and time. The SysLog packets sent by the GW3-TRBO SysLog module can have one of the following formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>&lt;PRI&gt; Message</td>
</tr>
<tr>
<td>RFC 3164</td>
<td>&lt;PRI&gt;[Mmm dd hh:mm:ss] [HOSTNAME] [Message]</td>
</tr>
<tr>
<td>RFC 5424</td>
<td>&lt;PRI&gt;[YYYY-MM-DD&quot;T&quot;hh:mm:ss.###-hh:mm] [HOSTNAME] [APPNAME] [PROCID] [MSGID (just a dash)] [Message]</td>
</tr>
</tbody>
</table>

The PRI is a numeric value that stores both the message facility (Local7 is always used within GW3-TRBO) and the severity. To determine the value for facility and severity, divide the PRI value by 8. The quotient is the facility, and the remainder is the severity.

SysLog PRI Facility Values

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>kernel messages</td>
</tr>
<tr>
<td>1</td>
<td>user-level messages</td>
</tr>
<tr>
<td>2</td>
<td>mail system</td>
</tr>
<tr>
<td>3</td>
<td>system daemons</td>
</tr>
<tr>
<td>4</td>
<td>security/authorization messages (note 1)</td>
</tr>
<tr>
<td>5</td>
<td>messages generated internally by SysLog</td>
</tr>
<tr>
<td>6</td>
<td>line printer subsystem</td>
</tr>
<tr>
<td>7</td>
<td>network news subsystem</td>
</tr>
<tr>
<td>8</td>
<td>UUCP subsystem</td>
</tr>
<tr>
<td>9</td>
<td>clock daemon (note 2)</td>
</tr>
<tr>
<td>10</td>
<td>security/authorization messages (note 1)</td>
</tr>
<tr>
<td>11</td>
<td>FTP daemon</td>
</tr>
<tr>
<td>12</td>
<td>NTP subsystem</td>
</tr>
<tr>
<td>13</td>
<td>log audit (note 1)</td>
</tr>
<tr>
<td>14</td>
<td>log alert (note 1)</td>
</tr>
<tr>
<td>15</td>
<td>clock daemon (note 2)</td>
</tr>
<tr>
<td>16</td>
<td>local use 0 (local0)</td>
</tr>
<tr>
<td>17</td>
<td>local use 1 (local1)</td>
</tr>
<tr>
<td>18</td>
<td>local use 2 (local2)</td>
</tr>
<tr>
<td>19</td>
<td>local use 3 (local3)</td>
</tr>
<tr>
<td>20</td>
<td>local use 4 (local4)</td>
</tr>
<tr>
<td>21</td>
<td>local use 5 (local5)</td>
</tr>
<tr>
<td>22</td>
<td>local use 6 (local6)</td>
</tr>
<tr>
<td>23</td>
<td>local use 7 (local7) ← Value used by GW3-TRBO SysLog module</td>
</tr>
</tbody>
</table>
Properties of the data:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Emergency: system is unusable</td>
</tr>
<tr>
<td>1</td>
<td>Alert: action must be taken immediately</td>
</tr>
<tr>
<td>2</td>
<td>Critical: critical conditions</td>
</tr>
<tr>
<td>3</td>
<td>Error: error conditions</td>
</tr>
<tr>
<td>4</td>
<td>Warning: warning conditions</td>
</tr>
<tr>
<td>5</td>
<td>Notice: normal but significant condition</td>
</tr>
<tr>
<td>6</td>
<td>Informational: informational messages</td>
</tr>
<tr>
<td>7</td>
<td>Debug: debug-level messages</td>
</tr>
</tbody>
</table>

**SysLog Connections**

The Connections list on the left side of the SysLog GUI shows all current SysLog connections. SysLog broadcasts each SysLog packet that it receives to each SysLog connection. These connections use unencrypted UDP (universal datagram packet) protocol, so the message is sent to the destination (Host Name / IP Address and port) even if the destination is not listening. There are many SysLog client applications on the market that allow you to:

- Monitor SysLog activity on a destination.
- Log the packets to file, database, etc.
- Send out e-mail messages, page a person, or trigger another event when a certain severity level is received.
- Route the packets to another location.
- Many more options.

**Creating a SysLog Connection**

To create a SysLog connection, take the following steps:

1. Click the + button. This will result in a new item being added to the Connection List. The new item will have a name like “New Connection 1.”
2. Click on the new entry in the Connections list. This will show the settings for this connection in the Connection Settings section.
3. Enter a value for Connection Alias.
4. Enter a value for Host Name / IP Address: This value can be any value that can be successfully resolved via DNS (Directory Name Service). Both computer names and IP addresses work. Notice that the default value is 127.0.0.1. This value is the IP address of the local machine.
5. Enter a value for Port: Port 514 is the standard SysLog port.
6. Check the Enabled checkbox.
7. Click the button.

**Deleting a SysLog Connection**

To delete a SysLog connection, take the following steps:

1. Select the connection that you wish to delete in the Connection list.
2. Click on the button. This will result in a confirmation message.
3. Click Yes.

Disabling a SysLog Connection

If you wish to keep a SysLog connection in place without sending packets to the connection, you can disable the connection. To disable a connection, take the following steps:
1. Select the connection that you wish to disable in the Connection list.
2. Uncheck the Enabled checkbox.
3. Click the button.
Chapter 10  WebServer Module

This chapter contains the following sections:

- **What is the WebServer module?**: Describes the role of the module within GW3-TRBO.
- **Web Server Configuration**: Defines how the WebServer module is configured.
- **Web Server Request Types**: Describes the types of requests the WebServer module handles.

**What is the WebServer module?**

The WebServer module manages incoming web requests to GW3-TRBO. The WebServer module routes these requests to the appropriate module in GW3-TRBO and sends the responses back to the client making the request.

The WebServer module does not have a GUI.

**Web Server Configuration**

The WebServer module has three settings that can be configured. Due to their nature they cannot be changed via a GUI and require the GW3-TRBO service to be restarted at a minimum. These settings are:

- **Port**: The web server port is configured during the installation/configuration of the GW3-TRBO host via the REST API port portion of the configuration. Due to its nature of configuring the host's firewall along with endpoint reservations, changing the port can only be done during this configuration of the host.

- **Request Logging**: Enabling Request Logging allows all requests made of the web server to be logged. Doing so can result in very large log files over the course of a day and as such is disabled by default. Genesis Support may instruct this to be enabled temporarily to troubleshoot web server issues. This setting is changed by setting the `RestApiRequestLogging` setting in the service's `GenWatch3.config` file on the host. It requires the GW3-TRBO service to be restarted to take a change into effect.

- **Verbose Logging**: In conjunction with the above logging setting, this will additionally log the body of each request and response. This results in even larger log files and should be enabled temporarily only when instructed by Genesis Support. This setting is changed by setting the `RestApiVerboseLogging` setting in the service's `GenWatch3.config` file on the host. It requires the GW3-TRBO service to be restarted to take a change into effect.
**Web Server Request Types**

The WebServer module handles three main types of requests. These are:

- **Statistics:** Specific statistics are available via the appropriate request mainly to drive various features used by GW3-TRBO iVista.

- **Alias Management:** To integrate with GW3-TRBO iVista, various Alias related requests are made to get, update, and retrieve alias information for resources managed by the Alias module.

- **Client Updates:** GW3-TRBO clients at version 2.15 or greater can be automatically updated after the host is upgraded. The web server handles these requests and allows the clients to download the client installer from the host itself. An update can be initiated by logging into the host from a client. The client will detect a new version is available and guide the user through the update process.

- **Client Installs:** Along with updates above, new clients can easily be installed with minimal effort. Using a web browser on any computer needing a GW3-TRBO client installed, navigate to a URL such as the following:

  https://{host}:{port}/GenWatch3/ClientInstaller/

  Just replace `{host}` with the hostname or IP of the GW3-TRBO host machine. Also replace `{port}` with the REST API Client TCP port configured during the installation/configuration of the GW3-TRBO host. This will display a page describing the requirements and process for installing a client.
Chapter 11  GW3-TRBO Notifications

This chapter contains the following sections:

- **What is a Notification?:** Describes the role of notifications within GW3-TRBO.
- **What Do Notifications Mean to Me?:** Explains why notifications are important to the GW3-TRBO user.
- **Working with Notifications:** Describes the process of dealing with notifications.

What is a Notification?

A notification is sent to GW3-TRBO GUI users when certain events happen on the system. Some events only target users with the Security Administrator privilege while some target all users. These events are like those available in the Trigger module. They use the same core GW3-TRBO notification process, minus the archiving of notifications, external relays, and responsibility logic.

![GW3-TRBO Notification Window](image)

**Figure 11.1 – GW3-TRBO Notification Window**

Above is an example of the *GW3-TRBO Notification* window. We have received several notifications concerning our input connection to a data stream. The newest notification is at the top. The topmost notification is “Link Down.” This tells us that we lost the data stream.

GW3-TRBO sends the following notifications:

<table>
<thead>
<tr>
<th>Type</th>
<th>Source</th>
<th>Targets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Existing talkgroup reported by data stream as a multigroup</td>
<td>Alias</td>
<td>Administrator</td>
</tr>
<tr>
<td>New Suspect Notification</td>
<td>SAM</td>
<td>Administrator</td>
</tr>
<tr>
<td>Link Down Notification</td>
<td>Data stream input modules</td>
<td>All Connected Users</td>
</tr>
<tr>
<td>Link Up Notification</td>
<td>Data stream input modules</td>
<td>All Connected Users</td>
</tr>
</tbody>
</table>
What Do Notifications Mean to Me?

Notifications are provided for several reasons:

1. To inform users of the status of the data stream, as it goes up and down. This notification will prompt administrators to attempt to restore the connection and will let other users know why they are not receiving real-time data. As a user or administrator, these notifications are useful.

2. To inform administrators of a data entry issue regarding groups. This allows the administrators to be proactive in correcting these issues. As an administrator, these notifications are useful.

3. To indicate Trigger events. Some Trigger events (set up in the Trigger module) include showing a GW3-TRBO Notification window (i.e., for additional warning that the Trigger event occurred). Sometimes a sound will play, or a relay will remain open until a user clicks on the Trigger event in the GW3-TRBO Notification window, therefore incorporating the GW3-TRBO Notification window into the Trigger event’s workflow.

Working with Notifications

When a module issues a notification, a GW3-TRBO Notification window will appear. When you select the event in the list, it will respond to the event. This means that all GW3-TRBO users (including you) will see your user name in the Recognized By column and the Response column will read Recognized.

When the GW3-TRBO Notification window opens, it normally appears in the same position it was in when the current user closed it. However, because the GW3-TRBO Notification window contains important information, it will always attempt to appear in a location where the entire window is visible to the user and, if possible, where the window fits on one monitor.
Chapter 12  Automatic Purging

This chapter contains the following sections:

- **What is Automatic Purging?**: Describes the need and function of the automatic purging operation within GW3-TRBO.
- **Automatic Purge Settings**: Describes the settings used for automatic purging by GW3-TRBO.
- **Viewing Purging Results**: Describes how you can view the results of the automatic purging operation.

**What is Automatic Purging?**

GW3-TRBO continually logs activity. If left unchecked, these activities would eventually take up a large amount of database space and decrease GW3-TRBO’s performance. To avoid this issue, GW3-TRBO performs an automatic purging operation every night at 12:00 AM. The type of purging is defined in the automatic purge settings.

**Automatic Purge Settings**

The automatic purge settings are defined in the *Purge* table in the *GW* database. The *Purge* table contains the following settings for each automatic purging operation:

- **ID**: Unique identifier for this automatic purging operation.
- **GWModuleID**: ID of the module responsible for performing this automatic purging operation. This value references a row in the *GW_Modules* table.
- **TableName**: Name of the table to purge.
- **DateAgeDays**: Number of days before an activity is purged.
- **MaxRows**: Maximum number of rows allowed in the table.
- **ByAge**: 0 if this table is not purged by age. 1 if this table is purged by age. Each *DateTime* column in this table is checked for a date older than *DateAgeDays* days. If one or more *DateTime* values are older than *DateAgeDays*, then the activity is purged.
- **ByRows**: 0 if this table is not purged by maximum number of rows. 1 if this table is purged by maximum number of rows. Each activity in excess of *MaxRows* is purged.

The *ByAge* and *ByRows* options are not mutually exclusive. A table can be purged with both the *ByAge* and *ByRows* options. In this case, the *ByAge*-based purging occurs first, followed by the *ByRows*-based purging.
**Viewing Purging Results**

The automatic purging results are reported in the Windows Event log if the purging operation removes one or more activities. See the *GW3-TRBO Service Diagnostics* section of *Chapter 3 - GW3-TRBO Service* for instructions on viewing the Windows Event log.